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DISCLAIMER: When saving material, it isthe user s discretitin to determine when to save material being worked on.
Material can be saved at any time, not just at the suggested steps. The amount of time spent on thework in progress will
dictate when to save the material.
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Final Cut Pro 1.2 - Editing Video

Starting Video Edit
Preparatory Phase
1. Launch Fina Cut Pro Application
2. GOTO File Menu >>> GOTO New Project Option
*an untitled project tab appearsin the browser
3. GOTO File Menu >>> GOTO New Option >>> GOTO Bin subOption
*this creates afile for placing your captured clips to
*it can be given a specific name by clicking on its default Bin name and renaming it accordingly
4. GOTO Edit Menu >>> GOTO Preferences Option
*the preferences window is now open
A. <CLICK> the Scratch Disks Tab
a. Designate the scratch disk
b. Waveform cache
c. Thumbnail cache
d. Minimum allowable free space on the scratch disk
B. <CLICK> the Genera Tab
In Levels of Undo, choose 10
In Recent Clips, choose 10
Place “ X" in box next to Automatic Save option, choose 5
In Multi-Frame Trim Size, choose 5
In Real time Audio Mixing, choose 4
Place” X" in box next to Render ahead, choose 2
In still image duration, choose 10 seconds
In Preview Preroll, choose 2 seconds
In Preview Post roll, choose 2 seconds
Place “ X" in AutoSync Compensator for movies, choose 5
View Externa Video Using, “APPLE FIREWIRE NTSC (720x480)
Place “ X" in box next to Mirror on desktop during playback
Place “ X”sin Show Tool Tips, Linked Selection, Snapping, Fit Full Size, and Visibility Warning
Set thumbnail cache (DISK) to 512
Set thumbnail cache (RAM) to 256
CLI CK> the Device Control Tab
“X" Enable Device Control
Protocol = AppleFirewire Basic
Time Source=DV Time
System = NTSC
Pre-roll = 3 seconds
Post-roll = 3 seconds
Timecode offset =0
Handle Size = 2 seconds
Playback Offset =0
D. <CLI CK> Sequence Preset Tab
a. Choose DV-NTSC
E. <CLICK> Capture Tab
Choose Online Quality
Frame size = 720x480, NTSC-DV (3:2)
Choose Report Dropped Frames
“X" Capture card supports
“X” Turn off Appletalk when capturing
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DISCLAIMER: When saving material, it isthe user s discreti@n to determine when to save material being worked on.
Material can be saved at any time, not just at the suggested steps. The amount of time spent on thework in progress will
dictate when to save the material.
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Final Cut Pro 1.2 - Editing Video

Starting Video Edit

Log and Capture Phase
1. Insert DV tape
2. GOTO File>>> OPTION Log and Capture
*In log and capture window, confirm that it says“VTR OK”
3. Chooseclip of interest
A. Enterinsert
B. Enter outpoint
4. Enter label
5. PressLog Clip Button

*|f successful, log will appear in browser window

*When all necessary material islogged from DV source, GOTO File >>> OPTION Save Project As. (#&*?@)

Capturing Logged Material

1
2.

3.

4.

5.

GOTO Browser Window

Select the logged entries by clicking on it with the mouse

NOTE: holding down the <APPLE> key and clicking on the mouse button can make Multiple selections.
When the desired logged material is highlighted, GOTO the Log and Capture Window,

Press Batch Button

The Batch Window appears, be sure Options are selected, have at least 2 to 3 seconds

Of pre- and post- roll handles

Click the OK Button

*When captureiscomplete, GOTO File >>> Save Proj ect

Adding Captured Clips — Canvas Window Overview
A. Video clips can be added through the Insert Portal, Overwrite Portal, Replace Portal, Fit to Fill Portal, and the

B.

Superimpose Portal

Purposes

Insert —allows you to add a sequence and will shift all material following it in the timeline window to the right
Overwrite — allows you to add a sequence at the point of the yellow marker in the timeline window. It will over-write
any pre-existing material

Replace — allows you to add a sequence and it will fill in at the beginning of a highlighted sequence and will stop and
the end of the highlighted sequence

Fit to Fill —allows you to place a sequence in empty track spaces in the timeline window

Superimpose — allows you to layer video clips in the timeline window

*To activatethese portals, a captured video clip from the Viewer Window must be dragged over the Canvas
Window

Adding Captured Clips to the Timeline Window
(Addl ng Seguences to the Timeline)

2.
3.
4.
5

6.

GOTO Browser Window

<DOUBLE CLICK> on captured clip of interest

*Will show up in Viewer Window

Roll the clip in the Viewer Window, by pressing the play button

Mark the in and out points

<CLICK> on the video image, hold the mouse button down and drag to the Canvas
Window

Place the clip over the overwrite option

*|f successful, it will show up in the Timeline Window

*When all of the sequences are entered into thetimeling, GOTO File >>> Save Project

DISCLAIMER: When saving material, it isthe usersdiscretiBn to determine when to save material being worked on.
Material can be saved at any time, not just at the suggested steps. The amount of time spent on thework in progress will
dictate when to save the material.
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Final Cut Pro 1.2 - Editing Video

Manipulating Video Sequencesin the Timeline
Altering Sequences
1. Double <CLICK> on desired sequence
Viewer Window
1. Drag video tab out of Viewer Window

2. At the bottom right corner, <CLICK> and drag open the Viewer Window so sequence’ s time can be seen
3. <CLICK>on Motion or Filterstab
4.

Choose the OPTION that will accomplish the edit of interest
*When a sequenceisfinished with the necessary manipulations, GOTO File >>> Save Proj ect

Removing Entire Sequences

1. Inthe Timeline Window, highlight the sequence of interest
2. Pressthe Delete Key
3. <CLICK> and drag the following sequence to close up the gap

Adding Transitions
1. InBrowser Window,
A. <CLICK> Effects Tab
B. OPEN Folder of interest
C. Choosetransition
2. Inthe Timeline Window

A. <CLICK> between sequences
3. Browser Window

A. <CLICK> and drag the transition between the highlighted sequences
*When transitions ar e finished being added, GOTO File >>> Save Project

Transferring Media to Another Source
1. Open Sequence in browser
*This step opens up the timeline and canvas
2. GOTO Sequence Menu
3. GOTO MediaMover Option

*Media Mover enables material to transfer with no breaks in the links

Adding Tracks
1. GOTO Sequence Menu >>> Insert Tracks Option

Deleting Tracks
1. GOTO Sequence Menu >>> Remove Tracks Option

Editing Specific Tracks or Channels
1. GOTO the Timeline Window
2. <CLICK> on thetracksfilm symbol and turn it YELLOW

Superlmposing Text Over a Sequence
A. AddVideo Track Below Video Sequence Track
B. Filling Text with Underlying Video
1. GOTO Browser >>> GOTO Effectstab >>> GOTO Video Generators Folder >>> GOTO Text Folder >>>
Double <CLICK> Text File
2. IntheViewer Window, <CLICK> Controls Tab
*Thistab allows for text formatting
3. Layout Text accordingly

DISCLAIMER: When saving material, it isthe user s discretidn to deter mine when to save material being worked on.
Material can be saved at any time, not just at the suggested steps. The amount of time spent on thework in progress will
dictate when to save the material.
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Final Cut Pro 1.2 - Editing Video
Superlmposing Text Over a Sequence (CONTINUED)

4. Inthe Timeline Window <CLICK> on Video Sequence (should be highlighted) that will be masked
a.  GOTO Modify Menu >>> GOTO Composite Mode Option >>> GOTO Travel Matte Alpha subOption
b. GOTO Modify Menu >>> GOTO Alpha Type Option >>> GOTO Straight subOption
c. GOTO Modify Menu >>> GOTO Reverse Alpha Option
*by highlighting Reverse Alpha Option and releasing the mouse button, turns on the Reverse Alpha Option.
This can be verified by going back to the Modify Menu and looking to seeif a check mark was placed next to
the Reverse Alpha Option. The check mark verifies that Reverse Alphais ON.
5. Inthe Timeline Window <CLICK> on channel below Video Sequence
a <CLICK> and drag the text clip from Viewer Window into the Canvas Window, (Drop the clip into the
Superimpose Option) or (Drop into the Timeling' s track and below the appropriate sequence)
6. Inthe Timeline Window <CLICK> on the Text Mask
a. GOTO Moadify Menu >>> GOTO Composite Mode Option >>> GOTO Normal subOption
b. GOTO Modify Menu >>> GOTO Alpha Type Option >>> GOTO Straight subOption
c. GOTO Modify Menu >>> Remove check mark from Reverse Alpha Option
*by highlighting Reverse Alpha Option and releasing the mouse button, turns on or off the Reverse Alpha
Option. This can be verified by going back to the Modify Menu and looking to see if a check mark was
placed next to the Reverse Alpha Option. The check mark verifies that Reverse Alphais ON.
NOTE: Video sequences containing many compositional elements may not necessarily be appropriatefor this
effect. When thiseffect isutilized, the viewer should be able to under stand what is going on in the sequence.

Superlmposing Text Over a Sequence

C. Adding Text Over Underlying Video
1. Procedureisthe same as Step B, but place the mask in atrack above the sequence.

Adding Audio
From Audio CD
1. Placeaudio CD in CD-ROM drive
2. Open CD from desktop
3. Drag and Drop the audio track over Final Cut Pro Icon
*|ocated inside Mac HD >>> Inside Final Cut Pro Folder
4. Follow theinstructions as they arise
In Final Cut Pro Viewer Window
1. Choose In and Out points of the audio source
2. <CLICK> and Drag the “Hand and Speaker Icon” from the audio tab to the browser window and drop the
track into abin folder
3. <CLICK > and Drag the audio track from the Bin Folder into the designated audio tracks

Rolling Credits or Text
1. Inthe Browser Window
A. GOTO the Effects Tab
B. GOTO the Text Folder
C. Double <CLICK> on the Text File
2. Inthe Viewer Window
A. <CLICK> and Drag the Video Tab outside of the Viewer Window
B. GOTO the Controls Tab in the Viewer Window
a. inthetext portion, typein the necessary information
b. inthe other portions, enter the fonts preferences
C. intheorigin portion, enter the coordinates

*x-values shift material to the left or right
(-)values move material to the left and (+)values move material to the right

*y-values shift material towards the top or the bottom
(-)values move material upwards and (+)values move materia downwards

DISCLAIMER: When saving material, it isthe usersdiscretibn to determine when to save material being worked on.
Material can be saved at any time, not just at the suggested steps. The amount of time spent on thework in progress will
dictate when to save the material.
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Final Cut Pro 1.2 - Editing Video

Rolling Credits or Text (CONTINUED)

d. Thefirst set of coordinates should shift all the text below the bottom part of the titlesafe box
Place the yellow insertion arrow at the start of the highlighted portion in the Viewer Windows Timeline
Mark this spot with akeyframe
Move the yellow insertion arrow to the end of the highlighted portion in the Viewer Windows Timeline
The second set of coordinates should shift all text above the top part of the titlesafe box
I. Mark this spot with akeyframe

*|n the Viewer Windows Timeline, the length of time the rolling credits occupy can be increased or shortened by
moving the in and out points accordingly

j- When the rolling text’s preferences are established, drag the video clip into the Canvas Window

TQ o

DISCLAIMER: When saving material, it isthe usersdiscretién to determine when to save material being worked on.
Material can be saved at any time, not just at the suggested steps. The amount of time spent on thework in progress will
dictate when to save the material.
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Final Cut Pro 1.2 —-DV Editing Terminology

Viewer: awindow that enables the user to watch clips, mark edit points, and apply effects.
Canvas: (RECORD MONITOR), awindow showing composited results of the edited sequence. Edit clipsin terms of sequence.

Timeline: awindow showing chronological view of the sequences. Video tracks are showed in descending order (ie: baselayer =
VI).

Browser: awindow used to organize and find source material for the project and final product. (NOTE: Browser contains no files,
only references, like aliases.
Browser Hierarchy:
1. Broswer = window
2. Bins=folder
3. References= dliases
Tool Palette: tools used to accomplish tasks in timeline and canvas.
Preferences: under edit menu. Use to change various options and settingsin Final Cut Pro Software.
Log and Capture: collect material and store to disk.

Item Properties. allows user to view or change information about media within a project.

Keyframe: point that is captured or marked on a video or audio track. Act as starting and stopping points for a assigned actions.

Final Cut Pro 1.2 — Useful Final Cut Pro Help Websites

WWwWw.2-pop.com

www.Videouniversity.com

www.dv.com

Final Cut Pro 1.2 —Useful Final Cut Pro Tutorial

DV _Companion for Final Cut Pro

DISCLAIMER: When saving material, it isthe user s discreti@n to determine when to save material being worked on.
Material can be saved at any time, not just at the suggested steps. The amount of time spent on thework in progress will

dictate when to save the material.
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